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1 Introduction

1.1 SCOPE OF THE EENVEST PLATFORM

EEnvest web platform act as a marketplace and bridge the gap between building owners, interested in
upgrading their buildings for reducing energy consumption, and investors that are willing to provide the
capital investment that generates profits through savings and energy efficiency. In parallel, the platform
will promote investing in energy efficiency in buildings by making the initial investment risk analysis
simple and attractive for the potential investors. The focus is on commercial office buildings, while the
solution will be scalable to be applicable to large databases and other building types globally. Finally, a
blockchain validation mechanism will ensure the validity of the data in the platform, allowing the
investors to trust that there’s no reliance on a 3rd party or there’s no data tampering on the platform.

1.2 GENERAL WORKFLOW AND CONCEPT

The platform is based on a Search & Match concept, that allows the different users (or actors) to
contribute in the growth of the platform. The EEnvest Search & Match will operate fully on the cloud
and will be accessible by the actors via a web User interface on a Web browser, responsive to all types
of screens and devices.

The workflow behind the EEnvest Search & Match is the following:

1. The Project Owner logs into the portal and uploads information which is describing their
building and potential retrofit project

2. Data is initially stored on a centralised cloud database

Once ready Calculation of KPIs is triggered by the Project Uploader/Viewer

4. The EEnvest calculation model is activated, it collects all necessary data from the database,
calculates risks and KPIs and returns results to the database

5. Results are ready for display to the user Project Uploader/Viewer, who selects if they want to
publish their project to the investors or not

6. To ensure the integrity of the data a blockchain validation mechanism is triggered which
encrypts all the data and the calculation model

7. The encryption message is stored as a new transaction on a public blockchain (e.g. Ethereum)

Public blockchain nodes verify the transaction

9. The User Interface automatically requests a check that stored data is validated, generates
encrypted message and compares it with the one stored in public blockchain

10. Investor is ready to view the public projects in the User Interface and filter/customise results
to find the best investment option based on their needs
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The host of the User Interface of the EEnvest Search & Match platform is the IES Collaboration
Cloud, described in paragraph 2, while the host of the cloud database and risk assessment models is
the Microsoft Azure'.

! https://azure.microsoft.com/en-us/
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2 Host platform — IES Collaboration Cloud

The EEnvest Search & Match platform is developed based on the existing infrastructure of the IES
Collaboration cloud?.

The ICL? Collaboration Cloud (CC) is a cloud-based information ecosystem of tools that facilitates the
storage, retrieval, querying, manipulation, management and visualisation of urban models. CC tools are
components of the Intelligent Community Lifecycle (ICL), a digital twin technology developed by IES
to create virtual interactive models of any built environment and the visualisation of key performance
indicators and data. The CC can scale from an interactive 3D environment that uses live data feeds from
any ICL tool for community engagement with the digital twin to integrated view across communities at
a national or even global level.

From a technology perspective the CC can be broken down into the following parts:

o Access API — A web API that allows the outside world to communicate with the CC.
e Data store - using Postgres.
e 2D - 3D viewer - a client of the Web API - can be run in a browser that supports WebGL.

ICL Community Information Model

Figure 1: The ICL collaboration cloud, view of the Community Information Model (CIM)

The ICL CIM tool has been repurposed to suit the needs of the Search & Match platform according to
the specifications identified during EEnvest project.

It is recommended that the CIM is accessed via the Google Chrome web browser®.

2.1 CIM WELCOME SCREEN

When the user clicks to open a project, the first thing that is seen on the iCIM project is the welcome
page. This welcome page helps to understand how to navigate around the project in iCIM.

2 https://www.iesve.com/icl/collaboration-cloud
3 https://www.iesve.com/icl
4 https://www.google.com/chrome/
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For Pan, Zoom and Orbit navigational options for mouse, keyboard and multitouch are provided for ease
of working.

e Pan: is used to move left or right when viewing the model

e Zoom: is used to move closer or move far away from an object in the model

e Orbit: is used to change viewing plane in the model

WELCOME

ICL Community Information Model

[k % O i)

Camera Controls Pan Zoom Orbit

Mouse ) Lefdick+drag (7] Mouse wheel (] Right iick + drag
Keyboard F_EIEl Cursaor keys - -

Multitouch b Single finger + drag ‘, Finch to zoom i Three fingers + drag

| Show on startup

Figure 2: CIM welcome screen

2.2 CIM TOOLBAR

On the top left of the CIM tool there is a toolbar, as seen below.

The toolbar consists in the following tools :

@ Home

It indicates the direction of the view, that can not be changed.
It is also used to revert the model back to the original opening/welcome page position i.e. World map
view.

@ Q Zoom

These icons allow to zoom in and out on the map.

L

Q5 Sun




This is used to generate shadows for the 3D model. This function is not used in the current version of
the EEnvest platform.

S Layers

This shows all the layers present in the model such as Roads, Hard Landscapes, Soft Landscapes,
Water Bodies, Buildings, and Boundaries etc. This function is set up by the administrator.

@ Custom Object

This function allows to create a new custom object, EEnvest project. The iCIM Project Viewer is not
allowed to use it.

The user can create new scenes based on the way they want to view the model. Any number of scenes
can be created and saved for future use.

v Filters

This function has to be used in conjunction with the Analysis tool.
This option is used to create specific data views in the platform. The projects which satisfy the filter
condition will be displayed while all the others will appear in grey.

ile Analysis Inspector

The Analysis Inspector uses thematic rendering to view data in the platform. Thematic rendering is used
to colour the pins based on a specific attribute, such as energy consumption, building total floor area
and any other numerical or categorical attribute.




2.3 MULTILINGUAL SUPPORT

The CIM tool is translated to all languages available using the Google translate function that is built in
the Google Chrome browser, or available as add-in in any other browser.

~ chrome web store

Home > Extensions > Google Translate

Google Translate

Offered by: translate.google.com
Y W W W W 43,856 | Productivity | & 10,000,000+ users

Available for Android. Getit. | (& By Google

Figure 3: Google translate tool in Chrome Browser web store

Once installed in the Chrome browser, the whole EEnvest project in CIM can be translated to all the
languages supported. The screenshots below show the EEnvest project translated to Greek language
using Google translate.
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Figure 4: CIM translated to Greek language




‘Ovop

Polite

A€

Via Vi

Original text

Name:

Click a word for alternative translations, or double-click to edit directly

Contribute Cancel

Figure 5: Translations showing original text
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3 EEnvest Platform in CIM

3.1 THE EENVEST ROLES

Two are the main roles as the end-users of the platform, besides an administrator that has full control
of the platform. These are:

e The Project Owner that seeks for investment in their building’s renovation project and
advertises their project in the platform by using the de-risking calculation model.

e The Investor that can navigate to see all the renovation project opportunities advertised in the
market place and select the best investment project based on their needs.

Below are the profiles of our two potential users:

The Project Owner can be either an occupant or a landlord that has identified that their building needs
to be retrofitted for energy efficiency to benefit from energy savings and potential value increase. The
Building Owner has performed an audit of the status of the building, including identifying the current
status, potential retrofit scenarios and their associated energy savings. The only piece missing in the
Building Owner’s puzzle is to calculate the metrics and quantify the risks associated to their potential
investment. The Building Owner might be a self-investor of their own funds or someone that wants to
attract investors that can fund their project and generate income from the energy savings.

The Investor can be a person that represents a financial institution or a fund, interested in investing in
promising projects that can bring back revenue with reasonable risk and payback time. The investor is
trying to find the best investment opportunities with quantified risks and, while possessing great interest
in mitigating climate change though “green” investments they are still sceptical about investments in
building energy efficiency retrofit project. The investor wants easy and reliable information about
investment indicators and risks related to such project, connect with potential Building Owners and trust
that the data they process is genuine.

The EEnvest roles described in 1.2 are translated to end-user roles in the Search & March Platform

EEnvest Name CIM Name Description

Search and match  EEnvest Project In the iCIM ecosystem, EEnvest Platform is an

Platform iCIM project

Administrator Project Owner The EEnvest administrator has the role of Project
Owner in the EEnvest Project

Building Project Contributor  The EEnvest Project Owner has the role of Project

Owner/Project Contributor in the EEnvest Project

Promoter

Investor Project Viewer The EEnvest Investor has the role of Project Viewer
in the EEnvest Project

Project Custom Object An EEnvest Renovation Project is called Custom
Object in the platform

Building Data Attribute The Building Data are called Attributes in the
platform

Risk Calculation  Action

In the Annex 1 all the roles are described together with their permissions. In the current version of the
EEnvest platform, the role is assigned by the administrator.

11



3.2 HOW TO ACCESS EENVEST SEARCH AND MATCH (ALL USERS)

The EEnvest platform can be accessed HERE.

From the EEnvest Search & Match Home Page, click on ‘Continue to IES login’.

MEnvest

EEnvest Platform

This action will automatically lead to the Sign in page. If it is the first time that you access the tool, a
new [ES account is required to be created. Click on “Click here to register” button, as seen below.

IES

Sign in
Not registered? Click here to register

Email

Password

In case you forgotten your password, click “Forgotten your password” to recover it.

12


https://icim-research.iesve.com/#/project-login/22556466-8c02-4970-90e5-4284933c8f7c

In registration page it is possible to create a personal account, by inserting name, email, and password.

[i]

Register
Already registered,

Firstname
Lastname

Email

Password
fepeat Password

I have read and agree to the

REGISTER

Once the account is created, return to the EEnvest home page to Sign in as described above. The Privacy
Policy and Terms of use are found in the Annex. The creation of IES account is free of charge.

In the current version of the EEnvest platform, the role is assigned by the administrator. Once the IES
account is created, the user is advised to contact the EEnvest representative to declare their role in the
platform (Investor or Project Owner).

13



4 Investor Workflow

Once logged in to the EEnvest platform as an investor, the following scene appears on the screen:

H ® @ Qloe # @8 VvV & . 8 &

7

’.-n The grey pins in the map represent the EEnvest renovation projects advertised in the marketplace
by the building owners, and can be selected. Hovering over a pin reveals a white dot in the pin and a
window some basic information about the building.

Heaaloxcs vk -

© Opmestrettie

Upon clicking the pin, the Attributes panel of the building is popping-up as seen below. The pin is

formatted again with a white dot in the middle. ™~

14



4.1 VISUALISING DATA AND RESULTS
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The attributes panel is displaying the project information together with the EEnvest KPIs for the de-
risking of the renovation project, calculated using the EEnvest Risk Calculation Model.

The attributes panel is also displaying the clickable URL to download:

e The EEnvest Risk Calculation Report in PDF format
e The Digital Report, verified using blockchain technology in JSON format

More details are found in paragraphs 4.4 and Errore. L'origine riferimento non é stata trovata..

4.2 FILTERING BASED ON RESULTS

The projects can be filtered based on their attributes using the Filters tool.

v Filters

This option is used to create specific data views in the platform. The projects which satisfy the filter
condition will be displayed while all the others will appear in grey or not appear at all.
To create a filter:

e (Click on the Filter icon and ‘New Filter’

FILTERS X
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e Select an attribute from the drop down list
FILTERS X

Select... Select... Select... ||

e Select the condition in the second drop down list
FILTERS x

Match All ‘

Select... Select... Select... [T

¢ Insert the value/variable in the third space
e Ifdesired, press ‘Add condition’ to create another condition related to the same filter, by
following the same procedure described above.

Match All ‘

FILTERS X

Select... Select... Select... ]E

Add Cendition Match All

e Once all conditions are created, click on ‘Match All’ or alternatively on the same button ‘Match
Any’. This allows to visualise the projects that match the conditions inserted according to two
logical filtering way:

‘Match AIl’ allows to include only projects for which both the conditions are true.
Therefore, the name of the filter automatically created by the software contains ‘AND’.

‘Match Any’ allows to include all projects for which either one condition is true.
Therefore, the name of the filter automatically created by the software contains ‘OR’.

Once created, keep the filter checked. Then go to the Analysis tool and select the same attribute to view
the results. The pins in grey are the ones that don’t match the conditions of the filter(s) checked. See the
example of the Analysis tool to better understand the use of the filters in combination with the Analysis
tool.

Use it to hide filtered entities. By checking this function, the projects filtered by checked filters will not
be visible. The pictures below show what changes when the ‘hide filters’ function is checked and
unchecked. The projects that do not match the filters conditions disappear when the filter is hidden.

16



FILTERS

(T Air Quality is less than 800 ppm
I 18 Acoustic Comfort is greater than 33 dB I

[/ Internal Rate of Return is greater than 5% SETTINGS

| Net Present Value on Investment is greater than

‘W
Expand all
0

[#] UNIT OF MEASUREMENT
[#] AcTION

[=] FILTERS

" Hide filtered entities

_ Hide unassigned entities
[¥] BOUNDARY PANEL

[#] ATTRIBUTE PANEL

[#] GLOBAL RESOURCE COST

[#] SIMULATION

[# Hup
[=1 INTERFACE
FILTERS
~ Air Quality is less than 800 ppm
| 18 Acoustic Comfort is greater than 33 dB I
| Internal Rate of Return is greater than 5% SETTINGS

" Net Present Value on Investment is greater than E
m Al

[#] UNIT OF MEASUREMENT
™
Deuts
0s
17

[#] AcTiOoN

[=] FILTERS

I8 Hide filtered entities

| Hide unassigned entities
[#] BOUNDARY PANEL

[¥] ATTRIBUTE PANEL

[#] GLOBAL RESOURCE COST
[#] SIMULATION

[#] Hup

Shall
© OpenSueetMap | [=] INTERFACE A en S| > ! il s Terms of Use Privacy

4.2.1 Example of how to use the Filters tool

FILTERS X
B Internal Rate of Return is greater than 5% & o
[ ] Air Quality is less than 800 ppm £ T
B Met Present Value on Investment is greater than 35% £ W
[ Acoustic Comfort is greater than 33 dB & o
[ | Internal Rate of Return is greater than 12% & o
‘ Internal Rate ... » | ~ || is greaterthan % | H 5‘% m

(o [ B

The filtered attribute is the Internal Rate of Return.

After clicking on ‘Add Condition’, add Net Present Value as second condition.

By pressing on ‘Match All’ / “‘Match Any’ it is possible to decide if the conditions need to be valid
together or separately.

17



In the example below, the two filters shown above are selected. When selected, only the filtered projects
are displayed in the marketplace. In this version of the platform, the filters are common for all users,
when a user creates a filter, it appears for all users to use.
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Payback time:
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4.3 PROJECTS COMPARISON USING METRIC VIEWER

[[El Analysis

The Analysis Inspector uses thematic rendering to view data in the platform. Thematic rendering is used
to colour the pins based on a specific attribute, such as energy consumption, building total floor area
and any other numerical or categorical attribute.

Using the metrics viewer found in the analysis tool at the top left toolbar, the projects in the map can be
colour coded based on user selected preferences.
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METRICS VIEWER X

Metric

Select..

Colour Scheme

ANALYSIS * I

Data Range

s . Min. value

e Metrics Viewer
(]
Colour code objects with attributes

Max. value
Display

C Ig Metrics Comparison T

Compare attributes across scenarios

To visualise specific data in the map:

e Select an attribute from the Metric drop-down list
Choose the Colour Scheme for the visualisation

e If desired, insert the minimum and maximum value (if the attribute value is a number) or leave
it blank; this allows to include in the analysis only projects that respect such range of values or
to visualise all projects without conditions.
Click on ‘Apply’ to visualise the analysis results on map.

e Using the invert button, the colours can be inverted.
The combination with the Filters tool allows to create a more complex and detailed analysis.

The metrics comparison is not functional in this version of the platform but will be activated in the
coming versions.

Example

Th selected attribute is the Internal Rate of Return (IRR). All the values displayed are fictitious and do
not represent any real building.

H® @ Qlo & 5 8 ¥ &

2 &
ANALYSIS x S!ocfhnlm Eest| W Q
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Metric Danmark

-]
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o e O Wil ST
Q Izmir Turkiye
i Antalya
. )
®
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METRICS LEGEND x
| ]

]
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In this example, the platform shows the comparison of Renovation projects based on IRR. The
renovation projects with IRR between 5 and 22 are colour coded with the highest value in green colour
and red the lowest ones. The projects that remain grey are outside the selected range. This way, you can
compare between projects based on the selected EEnvest KPI.

The Metrics Viewer can be used in conjunction with the Filters tool, see below.
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Colour Scheme s o Vitoris-Gasisiz Marieie
oy e’ Benrapus
Jens] ja Rom:
g Istanbul
Data Range o
Min. value -5 : Espana e aima
[ 0] ; - BT Izmir
Max. value - % Y il : - Rapa
[ ] 5 - s : Antalyal
MiR92 o,
Display N8 i
With valuss Rabai 06.E o
L
i METRICS LEGEND x
| |
e 76 I o2 2 i

4.4 CUSTOM SCENES

i Scenes

The user can create new scenes based on the way they want to view the model. Any number of scenes
can be created and saved for future use.

To be able to do so, first adjust the view using the zoom function. Then choose the filters to apply and
the data to visualise with the Analysis tool. Click on the Scenes icon and ‘Save current scene’.

SCENES X

Save Current Scene

Once created, it will be possible to update the name with a right click (as suggested) and finally ‘Enter’.
SCENES X

Click to view, right click to rename X

Save Current Scene
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This function allows to create several personalised views of the projects, with appropriate filters to show
and compare the projects data.

Hoa@alos5e v h = B

FILTERS x

@ Internal Rate of Return is greater than 5% 2

[ Air Quality is less than 800 ppm 2 m

[ Internal Rate of Return is grester than 12% 2\

|| Acoustic Comfort is greater than 33 dB 2 '

180 Net Present Value on Investment is greater than 35% 2E

N
&

| Internal Rate... * | ~ H isgreaterthan % | |
EIES]

METRICS VIEWER

SCENES

Metric

| Internal Rate of Return X | v ‘ EEnvest Manual

Colour Scheme IRR

C——

Data Range

IRR new

my scnene ax

Save Current Scene

Min. value- %
[ ]

Max. value - %

Internal Rate of Return - %

METRICS LEGEND

Internal Rate of Return-%

h e
P Terms of Use. Privacy,

For the purposes of this user manual, the custom scene called “EEnvest Manual” was created, as seen
in the screenshot above.

Using all the above analysis tools, the investor can identify the projects of their interests, based on their
needs and download the reports to find out more details.
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4.5 DOWNLOADING REPORTS

The EEnvest Risk calculation and the Blockchain verified reports can be found in the Attribute panel.
Select the building on map and scroll down. The two reports are generated by the platform and appear
in the Attributes panel of every project. To download them, click on the related links, as shown below.

<] ® @ @ © & 5 & V ik

ATTRIBUTES x

12.9

Net Present Value on Investment:

132
United Kingdom

Debt Service Coverage Ratio: Carbon Dioxide Emission:

Deutschla
153 600 ppm

] @
=
Predicted Energy Savings: Jobs Created: q
a

100 kWh/m2year 235 (Pl

EU Taxonomy:

Yes s

EENVEST PDF Report:
. M Niger

https://ieseenvestsa01.blob.core.windows.net/eenvestst... chad

’ Blockchain Verified Report:

https://ieseenvestsa01.blob.corewindows.net/eenvestst...

R
dér

Examples of such reports can be viewed in Annex 2.
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4.6 VALIDATING DIGITAL REPORT

The Building Owner has the option to generate a Blockchain validated digital report. This means that
an encrypted report is stored in Ethereum blockchain and it is unique. This way, it is a proof that the
report has been generated using the calculation model of the EEnvest Search & Match, and the specific
data and version of the Risk calculation model.

An investor can verify if the Digital Report is valid using a 3™ party open source identifier called
Blockcerts. These digital records are registered on a blockchain, cryptographically signed, tamper-proof,
and shareable. Certificates are immutable and cannot be updated.

B LO C KC E RTS HOME GUIDE ABOUT  COMMUNITY o GITHUB ‘ GET THE APP

The Open Standard For Blockct nti

Blockcerts Universal Verifier

B -

Choose JSON file (you can also drag & drop your file).

The user can copy paste the URL or choose the Digital report from the hard drive, and click verify. In
case of a valid certificate, the Blockcerts tool will show a window with info similar to the screenshot

below.
ﬂ_(r‘ Certificate of Authenticity

EEnvest

Issued on Jun 14, 2022 by EENVEST

v Format validation

1ltem =

v Proof Verification

8ltems =

' Status check

2 ltems =

Verified

This is a valid Ethersum Testnet
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In case of an invalid certificate, it will show the Error as seen below.

Certificate of Authenticity

Issued on Mar 24, 2021 by EEnwvest

~’ Format validation
| Hide =
*x

Error

Computed hash does not match remote hash

The user is also able to verify the transaction in Etherscan as seen below:

@ Etherscan All Filters ~ ~ Txn Hash / Block / Token / Ens n
Ropsten Testnet Network Home Blockchain ~ Tokens MisC « Ropsten
Transaction Details < >

Overview State

[ This is a Ropsten Testnet transaction only |

(%) Transaction Hash: 0xaBB7431426¢chd1cd37aBbd4cc297175002412f48412efead520765721ea4c83 ([

(@ Status @ Success

(@ Block: 12432114 262 Block Confirmations

@ Timestamp © 1 hr 2 mins ago (Jun-20-2022 08:02:48 AM +UTC)

(@ From Oxe38eeef35c10e33d077cb4e5ci67blaec3b26758 O

@ Tor Oxdeaddeaddeaddeaddeadde ddeaddead [©

@) value: 0Ether  ($0.00)

(@ Transaction Fee. 0.00043024 Ether ($0.00)

(7) Gas Price 0.00000002 Ether (20 Gwei)

Click to see More ¥
{0° A transaction is a cryptographically signed instruction from an account that changes the state of the blockchain. Block explorers track the details of all ransactions in the network. Leamn more about transactions in our Knowledge Base

In the same website, the user is also able to view the Blockchain verified report:
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&« cC O 8 blockeerts.org

ISSUER
EENVEST

DIGITAL SIGNATURE TYPE
A\ MerkleProof2017

ISSUER'S INFORMATION
raw.githubusercontent.com

ISSUER'S PUBLIC KEY

0Oxe38eeef35c10e33d077chdesch
67bfaec3b26758

TRANSACTION ID

0x398171d540891f6124dfbf5683
569fd1b99a2f72a3f0e014430aa0
3f599ac11c

oad Record in PDF Format

BLOCKCERTS

The Bpen Sandard Far Biacichain Credentias

Verify anather record

Energy Efficiency Measures

Investment Evaluation

Finangials

FINAN R Low
v ENT COST 1300000 €
YBACK TIME 7.6 years
TUR 10.25 years

NTERNAL RATE OF RETURN (IRR) 1333 %

NET PRESENT VALUE (NPV) ON INVESTMI 139%

SER OVERAGE RATIO (DSCR) 312

Multi-benefit

Building Details
OWNER
Building Owner Ltd.
2001
Office
ROSS FLOOR
46000 m*
Building’s Technical Data
Technical Details

9m

01234 56789

2019
1415

om’

380m’

25



5 EEnvest Building Owner Workflow

The building owner workflow in the platform is described in detail which includes the following
functionalities:

e Create Project;
e Populate Project with values;
e Run Risk Calculation.

The functionalities to visualise and compare results are identical with the ones described in the Investor
Workflow section.

5.1 CREATE AND POPULATE AN EENVEST PROJECT
Once logged in to the EEnvest platform as a building owner, the following scene appears on the screen:

Heoaalo #mE 8 v Rk I
t

1 o MEn ves

Moruhéa

........

)

On the top left, the button @ can be used to create a new EEnvest Risk Calculation Project.

5.1.1 Create the EEnvest Project

Use the ‘Custom Object’ icon to create a new Project, by inserting the name and choosing the Object
Type called “EEnvest Risk Calculation” from the ‘Select” drop down list.
Both the information is mandatory to be able to add a new project in the tool. It is optional in this stage
to enter the values for the attributes used in the risk calculation as it can be done in a later stage.
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H o a al o

ADD CUSTOM OBJECT %

Add a new project 2
4

J%En

est

Manage
3 O CaHkT-
Mame: e,
B o MNetepb
My Buiding Revawation | — Enter Project Name P Helsinki 4
EEnvest Risk Calculations — Select EEnvest Risk Calculations Eesti
Acoustic Comfort (dg)
Goeeborg
Address i Latvija
Address (e.g. Piazza Le. Piszza Leonardo da Vinci irge Kingdom
N attie . " Lietuva
Air Quaiity (ppm) o O L ‘G"Q“
ArTo A Hp Estinate... [0 iy A BN - benapyce
L Air To Alr Hp Number
r i ot
ik @
Kwis
o Chisindu
A
@
Ouied Bucuresti
o so¥ BwArapua
. : ¥ T | B istanbul
Click on the map to add new project —— O ey o _ :
P Izmir

In the current version of the platform, once the pin appears in the map, it means that the project is visible
globally for all users.

5.1.2 Populate the EEnvest Project

To populate the EEnvest Project data, click on the pin on map.
The dialog that appears, the Project Dialog, contains the data about that Project. Data are organised in
attributes, and all attributes are collected in categories.

Suomi ATTRIBUTES X
ATTRIBUTES x

[ expanaan ‘

Kingdom
Benapyc

Attribute names Attribute values

Deutschland

GENERAL

Categories BASELINE ENERGY CONSUMPTION AND COSTS

GENERAL

BASELINE ENERGY CONSUMPTION AND COSTS
BUILDING ELEMENTS - BALCONY TYPE

BUILDING ELEMENTS - BANISTERS

BUILDING ELEMENTS - CEILING NEXT TO GROUND

*I (ouTsiDE)

BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA

Niger

[=] BUILDIN EMENTS - BALCONY TYPE

Balcony Type Area

Balcony Type Estimated
Database Unit Cost

Balcony Type Total Cost

Balcony Type Unit Cost

0€jm2

0€

0€/m2

BUILDING ELEMENTS - BANISTERS

r&] BUILDING ELEMENTS - CEILING NEXT TO GROUND

It is possible to insert or update the attribute values by clicking on the ‘Edit’ button and filling the

spaces on the right side of the dialog.
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ATTRIBUTES x
N Sverige
. p—

ngdom
Bena

Deytschiand

GENERAL 'S EARGG

[#] BASELINE ENERGY CONSUMPTION AND COSTS

BUILDING ELEMENTS - BALCONY TYPE

BUILDING ELEMENTS - BANISTERS

BUILDING ELEMENTS - CEILING NEXT TO GROUND

(OUTSIDE) Ma Niger

BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA b

Once entered, the data are visible globally to all users of the platform.

5.1.3 Delete Project

EDIT Categories

General

Baseline Energy Consumptio.
Building Elements - Balcony t.
Building Elements - Banisters
Building Elements - Ceiling ne
Building Elements - Ceiling ne
Building Elements - Chimney
Building Elements - Ext.Wall -
Building Elements - Ext.Wall
Building Elements - External .
Building Elements - Floors - N
Building Elements - Floors - N
Building Elements - Floors - N.
Building Elements - Garage
Building Elements - Internal e

Building Elements - Internal e

Riiildina Flaments - Intarnal s 7

Save Cancel Run Actions.

Attributes X

Name

Address

Address (eg. Piazz...

Air To Air Hp Esti...

Air To Air Hp Num.

Air To Air Hp Pow...

Air To Air Hp Total..

Air To Air Hp Unit .

Air To Water HpE...

Air To Water Hp N...

Air To Water Hp P...

project 1

It will be always possible to delete the Project by clicking on the pin on map, ‘Edit’, and then the bin

icon, as the pictures below show.

ATTRIBUTES x
. sverige
—

fgdom

Deutschland

[#] GENERAL ES 6

BASELINE ENERGY CONSUMPTION AND COSTS

BUILDING ELEMENTS - BALCONY TYPE

BUILDING ELEMENTS - BANISTERS

BUILDING ELEMENTS - CEILING NEXT TO GROUND

]
(OUTSIDE) Ma Niger
Tchad J

BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA

EDIT

General

Baseline Energy Consumptio.
Building Elements - Balcony t.
Building Elements - Banisters
Building Elements - Ceiling ne
Building Elements - Ceiling ne
Building Elements - Chimney
Building Elements - Ext.Wall -
Building Elements - Ext.Wall -
Building Elements - External .
Building Elements - Floors - N.
Building Elements - Floors - N.
Building Elements - Floors - N.
Building Elements - Garage
Building Elements - Internal e

Building Elements - Internal e

Ruildina Flements - Internal e ¥

Cancel Run Actions

Name

Address

Address (eg. Piazz...

Air To Air Hp Esti...

Air To Air Hp Num...

Air To Air Hp Pow...

Air To Air Hp Total...

Air To Air Hp Unit ...

Air To Water Hp E....

Air To Water Hp N...

Air To Water Hp P..

project 1
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5.2 RUN CALCULATIONS

In order to run the EEnvest Risk Calculation and calculate the KPIs, select the project on map, then
‘Edit’ and ‘Run actions’. Where the calculation is completed, the output attribute will have the value

calculated accordingly.

ATTRIBUTES x

‘ :

Expand all

ngdom

Frande

GENERAL

BASELINE ENERGY CONSUMPTION AND COSTS

BUILDING ELEMENTS - BALCONY TYPE :"'l 03l .

BUILDING ELEMENTS - BANISTERS

BUILDING ELEMENTS - CEILING NEXT TO GROUND
(OUTSIDE)

BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA

assigned as contributors.

Deutschlar

Q

Niger

Tchad

EDIT

General

Baseline Energy Consumptio.

Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -
Building Elements -

Building Elements -

Ruildina Flement<

Balcony t.
Banisters
Ceiling ne
Ceiling ne
Chimney
Ext.Wall -
Ext.Wall -

External .

Floors-N.
Floors-N.

Floors - N.

Garage
Internal e

Internal e

Internal e

A Building Owner can only EDIT-DELETE-RUN Calculations to the projects they created or were

Name

Address

Address (eg. Piazz...

Air To Air Hp Esti...

Air To Air Hp Num...

Air To Air Hp Pow...

Air To Air Hp Total.

Air To Air Hp Unit ...

Air To Water Hp E.

Air To Water Hp N...

Air To Water Hp P...

project 1

0

In order to run the calculations, it is mandatory to insert the number of Monte Carlo simulations required.
This can be done through the attribute Number of Simulations available in the Project Data category.

ATTRIBUTES X

Expand all I

ngdom

GENERAL

BASELINE ENERGY CONSUMPTION AND COSTS

BUILDING ELEMENTS - BALCONY TYPE :“U""‘ /
K340 [

BUILDING ELEMENTS - BANISTERS

BUILDING ELEMENTS - CEILING NEXT TO GROUND
(OUTSIDE) Ma

BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA

Deutschla

O

Niger

EDIT

Investment Data

Multiple Benefits Data - Acou.

Multiple Benefits Data - Air q.
Multiple Benefits Data - Certi

Multiple Benefits Data - Perce
Multiple Benefits Data - Prod.

Multiple Benefits Data - Smar
Multiple Benefits Data- Ther.

Multiple Benefits Data - Visua

Post-Renovation Energy Cons

Prevention Action - Process f.

Prevention Action - Program

Prevention Action - Protocols

1| Project Data

RES - Other on-site electricity

RES - Other on-site electricity

Save Cancel Run Actions

x

Implement Renew... |Yes

#
Maintenance Oper... O
Name

“
Nation

P
Number of Simula.... 10
Optimisation Of O.. Yes

%
Optimisation Of Tr... |Yes

%
Optimised Solar R... |Yes

%
Predicted Energy 100
Renovation End D...

#
Rannwatinn O Cn Va ]

Once the calculation finishes, the results will be available in the category named ‘Risks’, that can be
found through the workflow shown in the pictures below. The two attributes highlighted in green will

contain the links of the Reports.
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ATTRIBUTES X

EDIT X
sverige
% Expand all I Multiple Benents Data- Frod. .
Name

Multiple Benefits Data - Smar
Multiple Benefits Data - Ther. Blockchain Verifie. ..

ngdom Multiple Benefits Data - Visua
Post-Renovation Energy Cons Climate Adjustme... O

Deutschlanc Prevention Action - Process f. Damage (%) o

Prevention Action - Program .
| O Prevention Action - Protocols Debt Service Cove... |0

Project Data

EENVEST PDF Rep... J
RES - Other on-site electricity

GENERAL .
RES - Other on-site electricity | ElectricEnergyGap O

BASELINE ENERGY CONSUMPTION AND COSTS RES - Other on-site electricity .
Electricity Price (€... O

1 RES - Photovoltaic system
BUILDING ELEMENTS - BALCONY TYPE Rigérie / 4
K """ / | RES - Solar thermal panels Energy Gap o
Sha (e
BUILDING ELEMENTS - BANISTERS RES - Solar thermal storage
EU Taxonomy
BUILDING ELEMENTS - CEILING NEXT TO GROUND RES - Solar thermal system £
(OUTSIDE) M Niger I Risks | Gas Price (€/kWh) O .
Tchad
BUILDING ELEMENTS - CEILING NEXT TO UNHEATED AREA ' _
. Cancel | RunActions imj

Alternatively, the Risks Calculations results can be accessed by simply clicking on the Building in the
map. This will open the Attributes panel visible to all users, as described in paragraph 4.5.

5.3 VISUALISE DATA AND RESULTS

See Chapter 4.

5.4 MANAGE USERS

A Building Owner can assign EEnvest roles to projects they own using the workflow below.
Select the ‘Users’ icon.

H® @ ;8 v Rk (=] &

J%Envest

Choose the user ID from the ‘Select’” drop-down list. The name of the user will appear on the right.
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MANAGE USERS

OBJECT ROLES

Select...

ADD

Permissions & Roles on Current Objects

Select..

Object Selection

Select

I—Dname of the user [}

Add to selected objects

Select the projects in the ‘Object Selection’ drop-down list. Choose for each project the EEnvest role

of the user.

MANAGE USERS

OBJECT ROLES

Select...

Permissions & Roles on Current Objects

Select

name of the user [

Add to selected objects

Object Selection

Project2 X Project1 X

Oumer X

Editor X

Project 1

Project 2

If the user has the same role for several projects, then it is possible to assign it faster by selecting the
role from the ‘Permissions & Roles on Current Objects’ drop-down list and then ‘Add to selected
objects’. CIM roles can be found in Annex 1. The role of project contributor allows another user to
contribute to a project already created by another user.

MANAGE USERS

OBJECT ROLES

Select...

name of the user (3}

Permissions & Roles on Current Objects

Owmer X

Add to selected objects

Object Selection

Project2 X Project1 X

Select

Select

Project 1

Project 2
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6 EEnvest Administrator workflow

This workflow is for website administrators that manage the platform.

6.1 HOW TO SET UP EENVEST PLATFORM

6.1.1 Step 1: Create a new iCIM Project = EEnvest Platform

Open ICIM in the browser.

Click on ‘Login’ and insert email and password of IES account. If not registered yet, see procedure on
how to create a new account in paragraph 2.2.

Log In

Email

Password

Not Registered?

To register for IES cloud simulations and other services please register first on our main website

The following procedure that allows to create the EEnvest Platform needs to be done only once.

In the iCIM interface, click on ‘New Project’.
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Available Projects

No projects currently available

A new window will pop up with the information required for creating a new project. The description is
not mandatory and can be added also later (see the instructions below).

Name:

Description:

n Cancel

Once created, it will be visible in the list of available projects.

E= Available Projects

EEnvest Platform

It is possible to add the description of the project by clicking on the 4 lines and the on ‘Rename’.

EEnvest Platform )‘ Rename

This project has no description

Manage Users

‘ Delete

‘ Publish H Open

Created

Created Mon Aug 02 2021 / Last Edited Mon Aug 02 2021

It is also possible to ‘Restore’ or ‘Permanently delete’ deleted projects by switching to ‘Deleted’.

Available Projects Deleted

EEnvest Platform Permanently Delete

| Restore

| Open

This project has no description

Created by

n Aug 02 2021 / Last Edited Mon Aug 02 2021

33



6.1.2 Step 2: Publish the Platform in the landing page

Click on ‘Publish’.

Available Projects

LU0l Deleted

‘ Delete

Manage Users

EEnvest Platform | rename

| Publish H Open ‘

This project has no description
Created
Created Mon Aug 02 2021 / Last Edited Mon Aug 02 2021

Complete the information required. The URL on the bottom correspond to the landing page through

which the platform can be directly accessed later on.

Project URL is published: w

No file selected. Recommended size: 500 x 400. Project logo hidden if none uploaded.

Title

EEnvest Platform

Description

Insert description to be displayed on the published page

Footer

Insert footer to be displayed on the published page

No file selected. Recommended size: 500 x 100. Footer logo hidden if none uploaded.

Upload background image | No file selected. Recommended size: 960 x 1080. Default background image displayed if none uploaded.

URL
https://icim-research.iesve.com/#/project-login/4602b264-fe05-4d85-afc0-3ba3acdd719d

This is the landing page the Administrator and all other users will have access to.

&@P:'Envest

EEnvest Platform
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6.1.3 Step 3: Add EEnvest Logo

Click on the ‘Settings’ icon on the top right and select ‘Interface’ > ‘Upload project logo’. Then pick
the image in your folders.

Hoaaoesxms v k & [&]

rrrrrrrr

It will always be possible to remove it by clicking on ‘Interface’ > ‘Remove project logo’, which
appears instead of ‘Upload project logo’ if the logo is already uploaded.

SETTINGS X

Expand all

UNIT OF MEASUREMENT
ACTION

FILTERS

BOUNDARY PANEL
ATTRIBUTE PANEL
GLOBAL RESOURCE COST
SIMULATION

HUD

[=] INTERFACE

’ Remove project logo

6.2 HOW TO SET UP EENVEST OBJECT TYPES, CATEGORIES, AND
ATTRIBUTES

Click on ‘Custom Object’ icon and ‘Manage’.
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HEoaa@ls 5 s v

ADD CUSTOM OBJECT x

=]

Name:

6.2.1 Create Object types

Insert the name of the new Object Type and then press ‘Add’ and save. It will appear in the list of object
types below. It is possible to edit and delete the object types by clicking on the buttons next to their

names.
MANAGE CUSTOM OBJECT TYPE *
v
Custom Object Types Add | Available Attributes Add || Tags Assigned Attributes
New Entity Type & W | Interest Rate On Loan 2T >
<
Banking Fees & T
Dscr Covenant & W
Equity £ 1
Debt LW _
Cancel Save

6.2.2 Create Categories or tags

Click on ‘Tags’, write the name of the new tag and ‘Add’ it.

| Attribute Tags

MANAGE CUSTOM OBJECT TYPE x v
e seline Preselected Fuel Expenditure £ [ * > |
New Entity Type -
ntity Type £ m = Building Information
Y em
Building Infermation - Energy Efficiency of Renovation Project
£
. Expenditure 21 Building Information - Energy production by RES
city Used For Heating oy Climate Condition
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6.2.3 Create Attributes

Click on ‘Add’ and fill the information required. Choose under which categories (or tags) the new
attributes must appear. Every attribute can appear in multiple tags.

Create Attribute x
MName:
Description:
MANAGE CUSTOM OBJECT TYPE x
v Type:
Custom Object Types A Available Attributes Tags Assigned Attributes Integer
New Entity Type nterest Rate On Loan Pl Unit:
<
£ W
Default:
D: t £ W
Equity £ Tags
Debt 2W

6.2.4 Assign attributes to Object types

Select the Object Type and the attributes desired from the first and second column and then use the
arrows to move such attributes to the third column.

MANAGE CUSTOM OBJECT TYPE

Custom Object Types Available Attributes Add || Tags Assigned Attributes
New Entity Type 2 W | | Interest Rate On Loan Z Tl
<
Banking Fees 2
Dscr Covenant At
Equity Z
Debt Z W

Cancel Save

6.3 HOW TO MANAGE USERS

Updates of this section will always be allowed; therefore, it will always be possible to add and delete
users, and change their role(s).

See Chapter 4 — Annex 1 User Permissions for description of the roles.
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6.3.1 How to assign iCIM Roles

From the iCIM interface, click on ‘Manage Users’.

Available Projects

EEnvest Platform
This project has no description
Created

Created Mon Aug 02 2021 / Last Edited Mon Aug 02 2021

One user is already present and correspond to the Administrator. Click on ‘Add Member’ and insert

Publish

Rename Delete

Manage Users | Open

A

the email of the new Project user, choosing their role from the ‘select’ drop down list.

Public access Allow project URL to be viewed by members of the general public: Yes

Email Role

Project creator Owner X

Add Member

Add User

6.3.2 How to assign EEnvest Roles

Select the ‘Users’ icon.

H® @ ;8 v Rk

Remove User

@
r1'ﬂﬁEEnvesi.‘

Choose the user ID from the ‘Select’” drop-down list. Then the name of the user will appear on the

right.
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MANAGE USERS

OBJECT ROLES

Select...

ADD

Permissions & Roles on Current Objects

Select...

Object Selection

Select

I—Dname of the user [}

Add to selected objects

Select the projects in the ‘Object Selection’ drop-down list. Then choose for each project the role of

the user.

MANAGE USERS

OBJECT ROLES

Select...

Permissions & Roles on Current Objects

Select

name of the user [

Add to selected objects

Object Selection

Project2 X Project1 X

Oumer X

Editor X

Project 1

Project 2

If the user has the same role(s) for each project, then it is possible to assign them faster by selecting
the role(s) from the ‘Permissions & Roles on Current Objects’ drop-down list and then ‘Add to

selected objects’.

MANAGE USERS

OBJECT ROLES

Select...

name of the user [}

Permissions & Roles on Current Objects

Quner X  Editor X |

v

Add toselected objects

Object Selection

Project2 X Project! X

Select

Select

Project 1

Project 2
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6.4 HOW TO SET UP THE ACTIONS

The calculations are named actions. Only the administrators can set them up.

Click on Settings, open the actions through Action > Manage, and finally, select ‘New Action’.

=
- UEEnvest :
[¥] UNIT OF MEASUREMENT
=] ACTION
“You have no actions.
‘ Manage ‘ Add & new 2cTIon Dy pressing the "New action” button

o O [+] FILTERS

[¥] BOUNDARY PANEL

+] ATTRIBUTE PANEL

+] GLOBAL RESOURCE COST
#] SIMULATION

#] HUD

=] INTERFACE

6.4.1 How to set up the Risk calculations action

Insert the name and the description of the action. Then, paste the json file containing the script. The
token status will change to ‘OK’.

ACTIONS x

[=] EEnvest Risk Calculations E

Endpoint

Action name Action description

|EEﬂvest Risk Calculations ‘ ‘ Calculates EEnvest risks and KPls ‘

Endpoint location Token Status
’|hnps mes—eenvesl—web—app—m,azulewebswtes,netﬂswag‘ ‘ ‘ @

Action path Action method Action to

Match attributes
Input

Endpoint attributes Object attributes v

Save Cancel

Select the correct path, as shown in the picture below, and choose the entity type from the ‘Action to’
drop-down list. Finally, hit ‘Match attributes’.

40



ACTIONS x

[=] EEnvest Risk Calculations i)
Endpoint
Action name Action description
‘EEnvest Risk Calculations | ‘ Calculates EEnvest risks and KPIs ‘
Endpeint location Token Status
‘mtps mes-eenvesl-web-app-m.azurewebswles.net/swag| ‘ |
Action path Action method Action to

’ Japi/v1/run_script POST EEnvest Calculations
Input
Endpoint attributes Object attributes =

Save Cancel

This is how the attributes must look like once they are correctly matched.

ACTIONS x

Endpoint attributes Object attributes

Address Address

Air To Air Hp Number* Air To Air Hp Number

Air To Air Hp Power * Air To Air Hp Power

Air To Air Hp Total Cost * Air To Air Hp Total Cost

Air To Water Hp Number * Air To Water Hp Number

Air To Water Hp Power * Air To Water Hp Power

Air To Water Hp Total Cost* Air To Water Hp Total Cost
Save Cancel

It is important to remember that the attribute ‘callback url’ needs to be matched manually with ‘(Flag
as Callback)’. Then save the action.
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ACTIONS x

-

Building Energy Management System Total Cost* = Building Energy Management System To...

Building Height Building Height

Building Renovation Year Building Renovation Year
Building Site Location * Building Site Location
Building Use * Building Use

callback_url * (Flag As Callback)

Carbon Dioxide Emission * Carbon Dioxide Emission
Carbon Monoxide Exposure * Carbon Monoxide Exposure

Save Cancel

Check Paragraph 5.2 For the description of how to run the action, what are the outputs generated, and
where to find the link of the report in the Building dialog.

An example of the EEnvest Risk Assessment Report can be viewed in Annex 2.

6.4.2 How to set up the Blockchain action

Insert the name and the description of the action.
Paste the json file containing the script, which is the same used for the Risks Calculations action.
The token status will change to ‘OK’.

ACTIONS x

EEnvest Risk Calculations E
[=] Blockehain Validation E
Endpoint

Action name Action description

‘Elockcha\n Validation ‘ ‘ ‘

Endpoint location Token Status
"hltps'mes-eenvest-web-app-m azurewebsites net/swag ‘ ‘ | @

Action path Action method Action to

Match attributes
Input -

Select the correct path, as shown in the picture below, and choose the entity type from the ‘Action to’
drop-down list. Finally, hit ‘Match attributes’.
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ACTIONS x

EEnvest Risk Calculations jmj
E Blockchain Validation E
Endpoint

Action name Action description

‘ Blockchain Validation ‘ ‘ ‘

Endpoint location Token Status
‘hnps Ilies-eenvest-web-app-01.azurewebsites net/swag ‘ ‘ ‘ @
Action path Action method Action to

’ [blockchain/{job_uuid} GET EEnvest Calculations

Match attributes
Input -

This is how the action must look like once the input and output are correctly matched.
Save the action.

ACTIONS x
‘ https:/l/ies-eenvest-web-app-01 ,azurewebs\les,net/swag| | ‘ - .
Action path Action method Action to
/blockchain/{job_uuid} GET EEnvest Calculations
Endpoint attributes Object attributes
job_uuid * job_uuid
Qutput
Endpoint attributes Object attributes
blockchain_verified_report Blockchain Verified Report

Save Cancel

After the actions are run by users (see procedure in chapter ) the attribute ‘Blockchain Verified
Report’ shown below will be populated with the link of the report generated by the script.
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ACTIONS x
hitps'/fies-eenvest-web-app-01 azurewebsites net/swa; =
[P PP 9 | | - .
Action path Action method Action to
/blockchain/{job_uuid} GET EEnvest Calculations
Input
Endpoint attributes Object attributes
job_uuid* job_uuid
Qutput
Endpoint attributes Object attributes
blockchain_verified_report I Blockchain Verified Report I

Save Cancel

Check Paragraph 5.2 for the description of how to run the actions and where to find the link of the
report in the Building dialog.

An example of the report can be viewed in Annex 2.
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Annex 1 — User permissions

Roles

Permissions

EEnvest role: Building
Owner

through

CIM role: Project contributor

See Chapter 4 for the
workflow

As Object Owner can:

Create projects;

Delete projects they own;

Write project data (update attribute values of the projects
they own)

Read platform (read data and attributes of projects they do
not own);

As Object Editor can:

Write project data (update attribute values of the projects
they can edit);

Read platform (read data and attributes of projects they do
not own);

Permissions are granted by the Administrator.

EEnvest role: Investor
through
CIM role: Project Viewer

See Chapter 3 for the
workflow

Read platform (read data and attributes of projects of the
platform)

EEnvest role: Administrator
through

CIM role: Project Owner

See Chapter 5 for the
workflow

Add user (EEnvest and CIM roles);

Delete platform;

Write platform (edit platform definition);

Read platform (read projects, data, attributes in the
platform);

Create projects;

Delete projects;

Write data (edit attribute data on projects of the platform);
Write attributes (create/edit/delete attributes for projects
in the platform).
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Annex 2 — Example of the Reports

EEnvest Risk Assessment Report
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\Uf/] EEnvest RISK ASSESSMENT REPORT -
=

GENERAL DATA TECHNICAL DATA
MName: Peitecnic & Miane. Conslniction year. 1072
Address: Piazza Leonardo da Last renovation year. 2015
Vingi Mian ialy

Gross Boof area: 758 m
Building usaypalegy: Office
Dvimeer: Buiiding Cwner Lid,

Gress valume: 2530 m"

HDD: 2400
Contact: 01234 56783
Investment cost: Energy savings
1306009 ambition:
H%
Financing amount
requested: PV production:
1000000 € 43200 KWhiy
) cted ‘Solar thenmal
maintenance and panels production:
Craiieil 3 J Renovation and mitigation
iy messures sopted:
+  Energy cemand
raduction
. = Cavily msulation
Project ambition: | x| |_ v
Rencuste the Buiking ta achieve 8 31 % redustion i - MNewFacade
tatal energy usage - Installstion of PV
Project Quality Seif.Assessment scare:
High prabisbility of relisble, consistent and acheivable energy savings.
0
Teennical sverage fsk
[ Needs attention }
Financial average performance
Multi-benefit sverage perfsmance

This project has received funding from the European Unian's Harizon 2020 ressarch and innovalion programme under Grart
Agreement n* 833112

fﬁ/] EEnvest RISK ASSESSMENT REPORT -
s

Graph n.1 - Cumuiated cash fiows Graph 1.2 - Project IRR Distribution

This shows the probabily distribusion of
T ) Sl U e B S IRR.’E:';‘ wakie on memmm?m axs has a
generaled by the project over Uime. The vakie for probabdity value, The areas undemeath the cunve
aach one of the years i calcutaled a8 the simple sums up to 100% probabiity. The blue curve
sum of the cash flow of thal year and ail the includes all risks, so 's more extender o the lefl,
previous cash fows. The graph cown below meaning thal there is higher probability that the
provides a quick iew of the time needed io IRR & low. The erange euve inchides only
payback the initial in cost. fRaneisl fisks, 80 s more coneanlrled aieLind

i SEETT— e

MULTI-BENEFIT PERFORMANCE
£02 EMISSION REDUCTION

The COZ Emission Reduction Indicalor esiimates ihe decrease of ihe COZ emissions as xx gy
resull of undedtaking e renovalion projecl INs derived from the predicled energy

savings, and if's appied a conversion facior thal varies Irom couriry o couniry as wel

s the type of energy used in the buiding.

EREDICTED ENERGY SAVINGS 1 00 —

The Predicied Energy Savings indicator is the difference between fie aciual energy
cansumgtion of the building (baseine) and the estmaed energy consumplion afr the
renayvalion project. It inchudes healing. cooling. lighting and vensiation.

NUMBER OF JOBS CREATED

The Number of Jobs Cresied mebic refers io new jobs crealed as a resul of the

invesiment. This KF1 is based on a prociaimed BPIE siudy thal siates that per 1 million

o invesled on energy efficency projects, 18 hew jobe on average are crealed. It 23 5081 6
depends: on the localion of he bulding {lor exampie. couniry) and the amount of the

invesiment.

For his specific project, the number of jobs crested s

This project has from the 20 innovation peogramme uncer Grant
Agreement n® 833112

4.

\I’",C/] EEnvest RISK ASSESSMENT REPORT -
A

TECHNICAL RISKS

The Damege indicalor guanifies ihe invesiment devison due o possible
mallunctioning of faikires of he energy renovalion measures sdapled in he renovation
project. Such desialion is expressed as a percentage of te planned investment. 0 00051

For this specilic project, the Damage indicator has been estimated as:

ENERGY GAP

On the other hand, the Energy gap indicalor quantifies the eneny performance

devialion. |l is expressed as a percentage of the caloualed enengy performance afler 0_0,‘
me renavalion project

For this speciic project, the estimaled Energy gap is

FINANCIAL RISKS

BAYBACK TIME

The Payback lime i the smaunt of lme hal fe nvestment will Lake 1o recover M infial
cost when e length of the invesiment lime reaches a breakeven poinl. 7 76 sars
¥

For this specific project, he eslimated Payback time is:
MATURITY

Thie Matusriy is defired a5 the total durstion of the project nesded 1o achieve  zero NPV
{IRR equal io cost of capital) ‘1 0 25

For this specific project, the estimated Maturity |s:

INTERNAL RATE OF RETURN (IRR}

The Intemal Rale of Retum (IRR) i he dsoount rabe thal makes (he nel present vale

NPV) of a specific project equal 1o zero. 0 1 3%
For this specific project, e Intemal Rate of Relum i

MET PRESENT VALUE ON INVESTMENT (NPV/investment)

The et Present Value (NPY) is the value of all fulure cash flows (posilive and negalive)

ower the entire e of an invesiment discounted o the present. The NPUfinvesiment 1 320/
Falic gves & mesasune of profiability of the project. . o
For this project. e esimaled NPViinvestment is:

DEBT-SERVICE COVERAGE RATIO [DSCR

The Debl-Service Coverage Ratio {DSCR) is an indicator of the project’s abiliy to

repay a debl Il is caloulaled a5 e ralio between the operalive cash fiows generated

by the project and the cash fiows for debl lease, or ofher obigations (debl service, 1 53
BOIN Tor inerests 3na pANCIRSI pEYENT) US i ore year -

For his project, the DSCR has been esimated equal i

T pecject has from the 2020 innovation peogramme under Grar
Agreementn® 33112
1.

V_rvrj EEnvest RISK ASSESSMENT REPORT .

Efros

The EU Taxonomy Compliance indicalor defines whelher of not the investment compies with

e minimum reguirements defined by the EU Taxanamy. In specific, Mar Ihe project being Yes
assessed has a minimum of 30% energy consumplion reduclion. . e a binary

meiric.

The Property Vsiue Increass indicalar biings light 1o the possible increrment on the value of

e asoel afler the renouation preject. This i ales referred as the ‘gresmism_ In practical Rental price.
fterms, I's nol possible 1o predict Ihis increase before he renovalion project. Therefors, this 2 5

meiric is uabiatve, and i provides a range of passible value increase backed-up by %
fiteratune, Sale price:

Far this ject, the Property - 10_20 .

The Link o SDGs indicator depicts b which specific SDGs the project conbributes lo. s 3
qualitalive indicators that showcases the nan-inancisl benefils of investing in the renovalion project.

This project has from the: 2020 inovalion programme under Grant
Agreement n* 833112
-5.
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EEnvest Blockchain Verified Report

EENVEST DIGITAL

Italian case study - IFAD

Energy Elliciency Measures 1 -

Investment Evaluation
Building Details

Financials
1 “RA RI ’
Low Building Owner Ltd. 11234 56759
13000040 € [
2001 2019
1M 7.6 years
10.25 veurs Office 1415
L L 13.33 % A6000 m* 0w
1,399
Building’s Technical Data
L ) iz
Technical Details
Multi-benefit gm 380 m?
e
Medi
Medium 43200 kWhiy 0 kWhiy
1,234 kg/kWhm*
1234 kg/m'y 31 %
JUCTION COS 12,345 €/m’y .
- O 5400
[ P 98763 KWh/m'y Renovation & Mitigation Measures
ICTED ENER ST SAVINGS 100 €/my o
May May
IBS 23.4 jobs / €1,000.000 .
Yes € 500000
Yes
s |
Yes Yos
Technical Yes Ves
17141142 .
Yes Yes
0.0%
i
R 440 Yes Yes
Yes Yes
Yes Yes

BLOCKCHAIN

VERIFIED

‘This repart is certified uzinz blockchain and can be verified easily vsing www Blockcert.org




Annex 3 - Privacy Policy

At the bottom right hand corner, these is the Privacy policy, it is the link to the IES Privacy
Policy which is also the same one that is covered under 2.1.3.

Clicking on the policy it redirects to the IES website (https://www.iesve.com/legal/privacy)
wherein our privacy policy is explained in detail.

The user is advised to read and understand the IES Privacy Policy.

Any queries about these Terms and Conditions, contact IES by emailing enquiries@iesve.com.
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Annex 4 - Terms of use

If not already read, we would advise the user to read and understand the iCIM License
Agreement before starting to use the iCIM project, found in:

https://www.iesve.com/legal/terms

Any queries about these Terms and Conditions, contact IES by emailing enquiries@iesve.com.
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